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Project title Sgt.Maj Thawee's folk museum full- flash website

Name Mr.Pramemanuch Intapong ID. 46211108
Project advisor Mr.Panupong Sornkhom
Major Computer Engineering
Department Electrical and Computer Engineering
Academic year 2007
Abstract

This project develops website for Sgt.Maj Thawee's folk museum by using flash
technology. Adobe Flash 8 is used for develop flash animation which is suitable for presenting
and interactive website. The deiails of Sgt.Maj Thawee’s folk museum are described in our
website by using mapping technique and the cartoon characters are the guide for users. This users

will enjoy leaming historical of Thai life-style via visiting our website,



=y =y
daanssnszma

= o ¢ o o a d A ¢ 1
Tasea3aanssuaouninaei dude 1dd0d fitesnnanuayAs1EH9INIY
PR '4 4 - o =2 o ol o
p11ssiay1 emsdaepwad geuau fngenlddtiny uuzihisnslumsdu
3
aaeatenisassgaunEmNuwiauaruaInamsud lvaaeaszus MM Ing s
2N v e W Jd? g} 1 oo Yo o O J::iy
VousamNI A3 YIouvad ARsSusRuThudm? neyanaldsainin ledil uazgamssm

=L

¥ 3
qu1? iiveedoyauaznmnitin

[ [
YA 1 N

o 8t 5 ] = 9 ] - ]
gatudmidlasveveunu dalidunerdesng v i ldwown w fitl inw
»
] ] o [ [ a = o o
YatiaouswlumaldinlSnu deyamazidaseld lassmdmnssuiidizaunnudus s

gaae ) ladun

w =y o
wonlsyns  aunnaY



N 1 e ] PPN

P N 1 L1 s FTTTTTT T U O PR S UR TP OT PP PRTPPRR

Y1 L AT KOO OSSO PP PP PO PP PSPPSR TRS

AVTIYFUNTI 1ot

T i IR T L1 IO e oo e YD TOTO PO
1.1 Ty ae o TS99, oo s
@ o
1.2 3 Usgaafuaa IASHOIM. oo e
13 UL TIBOR LETIITI . enneneeeeeeeeeseeeeeeeseeaes e st satrasraneeeeaaeaesaransmesansssaaees
L LI TS A I A TH e L or e cte et seeee e et e ereeeseeasasesanaaaeaneeaaaes s senmessbissiassasenns
15 RTINS TS o oot e et et eeint e ern e enee et be e ene e
L6 QLU TEHIT S oo e et raae e
c; ar =
ANT 2 HEAMTTUAZGEE . 112 vere s erriecriinaeatiise s nssssanssae e ens i
YN oy oo 3 [ ~
2.1 U523 Vo IRABARAHUIIUITI D oot eeirrrnee e emenee
2.2 T T15U AdOBE FLash B. o eeee st e e et eee e vt teentiaranscancanreasranat s rarnres
¥
2.3 AUGUMITIFOU Flash. ..ot ceecrs e
UTIT 3 TB MR U IATTINH e eeeeereeeeeeeeeeee s oo eaaaeeeaaeeasaes e e bbbr s b neeerreeeeeabus
3.1 MIoonuuu Insa1uiier INUABZ E I (Calalogies).........ccccvvriernriieineenn
1 ar :‘
3.2 MIBNUUULNUUUARHEOU 186 (Lay out & Theme).......vcoverieeiereeeeeann
»
3.3 p3 dgnau TutienIAasE M (Feattres) ......ooovveerericicci s
3.4 IHOUWSGABITUE (UPI0ad) .....ooveveiriiinins e
LTI 4 BANTITTIAEDY. « oo erereeeseeeeeseresss e eaaeesreseeeeataesanatsseeaaneeeeeranreebesannnesseaan
AL T THE T oo e e e e e ettt et a e a e e
A0 AU AR TI T TN TT . evvneeeesseeseee et s eeeeesaaserssaaasassasaeaaeeaaaeaaassnnnnns
B3 B IUBALIEAIN I oo e e e e e e s e s ee e et eaeeeeeeeassannasesnnnne s e e oas

A A



M3y (A9)

A5 P IRUDTDM oo e e e e e e e e e e e s e ee e e eeeeesesaass e s esresvensonetsssassessessassesas
4.6 T IHUDINTERTHEUNI . . ooe oo ee e e e e reeen e e e s eeses s ssessiesasssrens
=
AR S AU oot
S AFUHAMTAARDA. ..ot e e
5.2 M IMOZUUIMIBIA LU, oo
5.3 O BT IH S U IBINY. . e eiireereeeeereeeeeeree e eeeeee e e eeeeaareessseneeens
L T~ D o i o P N ST U R
@r 1 kY
AAHUIN 1. 720019071553 190HA I TUTUNTU Flash. . oo ieee e eeeeeeeeeees e
AIAHUIN U, A1THE1 Pre-Loader DUTIIM. ... vveeeeeesseeesesseeeesseesereessesesmsassesesmresressons
¥
AIRHUIN 0. LAAIHAIA TORTY Flash DA, ..o ooor et et e e e e eeeereressenseresesies
marn 9. M3 naagilnmoinnisuenn 1l Flash........ooin
MAKUIN 9. MIIFOUADTZNAT Flash A1 XML UGBS Text Filee... vueerrrerreeereeieaisiierenns

USEIRPTOUTATIII L. vttt st s et



AIVYAITN

= 9/

M5 1N Wil
b

1.1 VUADUNITAUMUII .t eeesesavsesss s ssssssessasses e s ess s asasssssssesescesseresseneos 2

5.1 15 19aa e Azt N IUNMISUATIOM L e 21



CRRIS TP R

31l7 Wi
gﬂﬁ 2L THIE BAL. ..o eeenete ettt sttt sen e er ettt s aae s 6
gﬂﬁ 22Menu Bar......ooiii e e 6
Eﬂ‘ﬁ 23Tl Bar, . .ivi i e 6
gﬂﬁ 28 TOOIBOX. .ottt e s e e e e aa e 7
g'ﬂ‘ﬁ 2.5 TIMeline. ..ovvvnv i 7
FUT 206 PAIIEL. ..o eecit e e rs et e 7
3 ‘lJ‘id’I 2.7 Library... g« o 0 N N T My 8
gﬂ‘ﬁ 28 Layer gl . Jrmms e T AN e 8
RN Lm’ﬂ\‘lﬁﬂﬂiﬂﬁgwﬂ‘ISI.l‘IJ'\'lHiJ’Jﬂﬁial:u‘fElH1 ............................................... 10
317 3.2 Fedduladilsznon 180 3 damMEn.. ..o 11
317 3.3 LA AARMAREII. ..o 11
5107 4.1 awuerasdnilsenounARURIN B, oo 13
5117 4.2 nneraan i EnvouTu 98 (homepage) .. .vvvivv.irveemer e ceeesreer s 14
gﬂ‘ﬁ 4.3 MALAAIE TUTAUAAIINTIANT .ottt et 14
317 4.4 amuaassnSanassiinssamsngnuuvseniil 2 dauamandisius 1S
U7 4.5 MNIERIEMTANTAITNTIAATIAINR oo 15
717 4.6 MR ITAUIASTINITAN TN 210 e 16
91l 4.7 ATRLARIFIE TN T MUDINIS SAUARGTINTIAMT ... 16
U1 4.8 MIHHTAIEIUTAUTAININ. ..o cennssnse e 17
51171 4.9 MUFI0S 13T VUFATHRIANIYUIR 360 DI .oo..oirrr e 17
3171 4.10 MIAFIOOWATUVOIRATEAN. ... oo 18
317 4.1 mmdedeszunsatimmiia st guenIf. 18
31T 4.12 NTHEIBEWHUIUBURY ... 19
3109 4.13 mmuananud@thauludulag. 19

71 4.14 MUUAAIT IYBINILAMUAUNU L ..ot 20



o
1.1 HJaymuazinvealassny
Y- Jz?l‘ 97 ] C- I 9 [~ o J cg 2 ) = ooy o o
“ginsrmanAutiusmd”  Idmailuilsziauaunnimin Arwmgndl WNsHam
<4 n' = ol e | ci & =8 ¥ Qs d'i
vioadude vesdaniafiugylanfillavunaion 20 1 arvvzdeslladiaanizilguusos
alde
=T (.Q‘,‘ 'y 1 4 =] ey e o (= ~ A . Ay
“ARBAMARUTIUIINT luRAs ANV NFUBNNT 1)500U9A FAUNTUD 379
= A TR A Ao a ¥ L=} ¥
ANvAa ALYy d1 a1 01e wie Fianndennyosyathunolueda 9nd1ves
4 y.g ¥ & ¥ A 1
wiealamuty Fadaulng ldunnnnmamitieasums
5 { as o o 1 ar = 1 ] Qs
iafiozsnyuemnsuel lumssnuaz tensadausisuiesiuidunnuiunas mI
o - a WY v Qs 1 [] =1 o 1 = Y A A 1
dweuedall Jansasusinm e doadiolnd i ol dewdludndenilansromouns
v o 3 ar 3 2 9 ar = W ~ 1 A 1
Tyanani 185 unsusumisdnyimanuinazinwigiilygimesdiu Hiunsevy
a o o
BUMBIITA
3 4:'1“ Yo o W P o g O o oo oo 0’:9;’ 9 1 =g 4
Wiail gvavir ldaulafisz darvinin ladussidniusiiuihunmidrwogduynionay
ot ¥ . A 3 @ q a
Tautfun 15Wannd oo Flash Animation & Interactive ihimanmoanuasaulumsivaues

- =5 oy o
uazdsgannuaulalumiSsuivesyanani il

d
1.2 ngilszasnveslnsany
A o < J ’ o @ aa w o’r_':’ 1Y 1 e o
1.2.1 tefany lwdiuy Full- Flash Website M IUANEAMAMLIMNIMI Sanda
WHDY lan
A8 w o os 2 ¥ o . ¥ .
1.2.2 iiefnu ez et UL leanuy Full- Flash Website A9t Macromedia Flash (a2
or d ° . .
Aayupudlszneumsiiianed9A20 1 Flash Actionseript
A L] ar L] A =3 o Ql 1
1.2.3 thevwduauuasinuds o Lideiml Tausssuestuves no lilvigey
W'l
4 o ar oy o -y 1 4 ] 4
1.2.4 e Tyanam I 14 Tnuazsdhsuidissusudhusmd imemanudinie
=" d o 1
A laaesiolvu
g - = @ A w o 3
1.2.5 el uSmIguan A lnneveaminedsiaivaumniesianuimn

Waneadu



1.3 YaU18va4lAsINU

1.3.1 ﬁny11.Lazi“)”ﬂﬁﬁu‘lcuﬁﬁﬁﬁﬁmcﬁﬁ”uﬁmiim% (Sgt.Maj Thawee's folk museum
Full- Flash Website) A70 Flash Animation & Interactive éﬂﬂi%ﬂﬂuqﬂﬁﬁﬂﬂﬁ%ﬂuﬁﬂﬁ
M3 3AM3, Satiunn uasinud

132 anymaziennudd iy Full- Flash Web 200111 Flash Actionscript

133 Anvwasiennesilszneuit S lundadenisGoudidu e Full- Flash
Website ﬁ'aﬂzﬂ?mﬁa%uqﬁsﬁm%m'lé’furi Tu51n50 Macromedia Dreamweaver, Adobe

Photoshop (Huduy

1.4 UHUMTAUHUIY

1 ¥
M3 1.1 Tunaumssuiiay

2550 | 2551

n.e, | A | Wo. | 5. | WA | DA | WA, | 1LY

—
2]
L)
=
[
)
[¥%]
=
—
b
L
B
—
=]
]
ofn
—
3]
[ %)
oy
—
~a
(75
I
—
[
L
Y

AN T 112[34

1. Anpgmuumsinaueranuly
Y- o v = ¥
HWHBN UL A IlﬁSﬁﬂH'lﬂ\'ﬁJElu'ﬂ

Y- &fd'l.v 5 1 =
TURAS S N WU IHTIND

2. AYUAS 091D (Tools) DY

wa TuTaan s lumanenn

3. AN INURHAZA19613 Application

TuanyMEA199

¥ g A
4. szanadoyavianuaiile

.

s, WAz Uy

6. NAFoUTTANTNMNUOITTUY

o b4 ¥ =
7. ﬂ’]ﬂ']'iunuhﬁlﬂﬂﬂwa'lﬂ

8. agtondaidovasszy

9. sarinenasilsznouInseau




S ' Y
1.5 anmanazlasy
N g d d o an o o : = 9 4o w
L.5.1 eusnahady lsdminaueifissuauazitfudomsGouioou laidmiy
oa w I's 4 ] ju
wwmmcnﬁuﬁmmn"i (Sgt.Maj Thawee's folk museum Full- Flash Website)} AUANUN WU
I ude uazldauldesa
d . d = 4 4
152 1850 ey Full- Flash Website dludnnilamadenlumsdhidousy
Ao o do ar :Vd' ] a @ ar @ A E ] =) o 3 1
AnssudmIudn luazamaunangddmdaivng lan Moodummazsnugze 3
A M 4 '
Fero ) Imusssutesinuesinelildgyme’lyl
1 1 M
1.5.3 yanaia I 1@ uanumdamauuasanudinnafuadsAuihuuag3ns
o s 1 =3 1 I~ foa o n‘.ﬂy 9 T = A Y = 1
dgraiiavesdauiuedarudi laaRisdustnuiunm gazmadlumsiiuSmsunguad

Tuviesnu

1.6 suszanamly (1,000 1AL
161 shldwlunsdemisdegile 800 UM

1.62 mldswlumssaigliauisam 200 1

¥y 9
FNITY 1,000 UM



P
Unn 2

HanMIATNGYY

ta4dis (Tooks) Mg lumsandyladRitsAuaifutuim? 1duA Adobe
Flash 8, Adobe Photoshop, Macromedia Dreamweaver L10% Edit plus Llﬁiiﬂillﬂinﬁﬁ'ﬂﬁﬂl%lu
mswanylad Ao Tilsunsy Adobe Flash 8 713 lumswanswiulad@iounas (Flash
Animation & Interactive) A4 TUsunsuiiianumsalumsiannawndeulnofiawise
Waoududrndyleduasfimmsmindoanziafmidhu [ namaudumsinaue
aufummnaonTna1g dudensy Indudaoz 18 dduuana sw Avgth ) iduaasma
iy idsu s udulad 3aTogiuTisunsy Adobe Flash 8 dlumesiladun
Fanuawnselunsadnmniuauedinaidaseunquineasissinaiiga

hamilosndnialss Ranudunvesifsfusituthusm unsdse 3 Tusunsy

Fd

4 @ =1 os o [ P
Adobe Flash 8 #9uz 19 lumsRaundiu ladfinssuaifuiuemd aeli

aasy o -V ry -, L =
2.1 ‘lJ'S%'Jﬂﬂ')13Jl‘lJNN1°lJﬂQWWﬁﬂﬂJ‘T‘IWHﬂ’IH%'\“')
Sa oW u‘ay 9 1 = =Y oy & o 3 1o = = e oad or
ARspauAuThuemd rFuennd-wud yiuwad) asegiouwdgnindaid ludd
a4 = dd v A qwd w 4 A A . o
wesdivgylan  Wuiinusausawdrveuniealdiuim Fuduniediomunmiinues
1y =) 3 lqy o =£ g ’ 1 a4 o & y = A A
snthulusia dwadudn o swdwulng Wy miesina nsesilumum wiedlslu
- | A = 1 A =y :’ 9 -~ A FY A A e v w
asasou nsoald umsszneuodm i mieadmiaivile 115048917 inT0el0ANTUTA?
or F A r:y 9o W w o YN o oy
swmudnimiugy aldsunsouiuhihunsndmalzidmdsasuasgiivyanine
uagld5us19Taveabougadmns suteafies nolsznmmbsnuauasulazAienIng

Yoo 1ol 2541

L= = o 3 3 Y- Ea~ ydlddd. =y
duen a3, w3 Yivad GnedsAnssudt Wudhiidielumalssdinnssy uaz
o = = 4 o 1 f a o
WRumsdagies@nnne  vuldsumsendedd ity yaraAdumeTanss suaang
t v ' o = a = = J oo
grdilile nustunde Uszdil 2526 wazldSuwszsmmulieAndmaniqufiide
4 ¥
AaAufnAnINIMIMABAS UATUNS A lsaazuninedefalng  saunimslsenimiosa
aouihunuddivive lan”
o o (dv V¥ ] -:? 3 3 ar Y o e o g 1
fnsAnatAut el Aaldidmmniu AuSusuns dudna 8.00-16.30 u. Tao

1 1 o t =
Alnajidoand sy 50 1M 180 20 1M ¥1IAAE 100 VN



2.2 T1/5un531 Adobe Flash 8
<Tatl 1N ey (Adobe Flash) WioFodufie uninsHide uas (Macromedia Flash) iy
d‘ i Q4 =) dr 3 H or E§ ot
TusunsunlFlumsdsudoiantimono 1 1Fafaflonunoany Flash #9472 Flash Player
ar [ PR o A Y a a e o o or - [~
Wanusazmouns 1ao oz latimand (Gudurinnniaousin #useiuds aouraulasualu
a A 4 o o ¥ - & ﬂ Ae gy d
unlnsiife  Fmendsgnanuswdmsiniy exlad ) Fudluldsuesuiidd O
s o @ & w o o
Wws M iaes awsouaadaaiuld duiulanuamsalumsiesil MHIUUNNNDT 1ag
o =t a | da -~ ] g o o ogd
MWLUUUS TINDS uazinuaaslamo 131 on laomwiziEonh wonsuaniila
. . 4 a (ddad a |4 . 4 g
(ActionScript) Fathunnaasdaniiuguunnadnunansild (ECMASeript) Fuiluaszga
A o o a | d Yo o w o P ¢ d e ¥ A g9
doaruiunmansld  Fdmsunianndy ladusevordusihaudeunay  Wald
funauazaguniluduasy uazIfanse ldaounud 14 lanazdsanninay
@oaaz3ale unnmasla’ld
1] o P A .
palunnuminese  uar  uvlay  Aslilsunsuiuuy  integrated  development
. . % 1 4
environment (IDE) (a2 Flash Player ﬁﬂ virtual machine ﬁ"l%'“lumsmamammm'lﬂﬁ llﬂfﬁﬁlﬂ
» M
lunmnnaseeBoniarosmiiilunumnu@odu: udase dramnsaanuanuda

TilsunsumiaaiioneduaasIiavis TWd lsunsy

gluw 1WA Flash

swf WA swe e Rauysel, gn compiled Liag published AU Felimmsoudly
@8 Macromedia Flash ‘1aonsa i, agnalsfian, a3 l1sunsy "swk decompilers' 8¢
An.

M. WS 0a ShilWdduntvealasunsy Flash, 1sunsuiilfi@ou Flash aunsoudly
Id FLA wa compile Tl Ing swr 18, at1alsinm giunlWd FLA Sl
fvuathion "ila

Av ulﬂfl{ v Lﬁuvlﬂfﬁﬁiﬂ Flash, é-&ﬁ %"NI?IEI Macromedia Flash, Sorenson Squeeze, EL
On2 Flix.

avi WS av dhiIndaTo, dusideves Audio Video Interleave. B9 Flash a1130a319

Izt 13,

.spa wd spa folWdlonaisves FutureSplash.

~

o o . A =] 1 ot [ |
xml W& xml f9'lW8 configuration ¥6e flash FeldAudeyah lidesmsnaninalmi wu

fink 13lud,



194 Flash anioléld

.avi I'ME{ AVl ;ﬂu"lﬂﬁ?iﬁia, L“:L(’uﬁ’lEjme Audio Video Interleave.

gif  mwadeu’lv GIF
o 2 2 2 I LY & oA 1 n‘tls)
pog WS png fe IS pNG Feawmsemudluldmends @addiimsimianiwei])
o 2w A L
waannhTiuAn 13
.ssk bl‘l‘vlﬁ‘ .ssk ﬁﬂ‘lﬂﬁ' SmartSketch,

4 = @
piv vla .piv fo IWdueding Pivot StickFigure

&
2.3 Wug1umM 315914 Flash
»
Tudwilsznantsdiudiznovveenigiglalsunsy Macromedia Flash Uag Panel

] < o 1 ar ;
AunuRuEINFUNUANY ANl

e Title Bar na@i/uaunuyan (Control Menu), ¥o Ttlsunsu uazijumuguuiiig

Tilsunsu

U 2.1 Title Bar

o  Menu Bar LER9519MIA169A199 voe Ilaunsy

gilﬁ 2.2 Menu Bar

«  Toolbar uarastjunsasiiemamananasgiuves lsunsy wu fudlaaulmi, la

TWaonas, saufiuldd Kludu

gﬂﬁ 2.3 Tool Bar

9 A = or ¥
e Toolbox Llﬁﬂﬁ'l.!mﬂiﬂﬁilﬂlﬂﬂ"]ﬂﬂﬂﬁTIﬂﬂTW TIWMNA



YW¥NO e\ x|

N o= B

g

o
9]

g‘lj‘ﬁ 2.4 Toolbox

1 o a o 4 1
+ Timeline Wﬁ'm'ﬁuﬂﬂﬂﬁ'uﬂ'ﬂﬂﬂuﬂa’lﬁ’lﬂTUﬂ'liu'nffNE}Nﬂ\ﬂu lsznevdivaiu

Mauneanu Layer 122 Timeline

Twaonad animalion
Framo-by-framo animation
Timeline heador
Guide layer icon Playhead
Empty keyframe

Frame View pop-up menu

Tunehne

Center frama button Elapsed time
Onton-skinning butlons Frame rate
Selected frame numbeor

gﬂﬁ 2,5 Timeline

¥ o 2 a £ w Y
+  Panel ﬂu1m13ﬂ?UﬂuﬁqnﬂfHQ1u "ﬂ\iuﬂa_lU'NQﬂsﬂu (ﬂﬁ‘IU’H‘MMN)




ar | L ::lw
AnHAUSTHINN AU

naw om0

gﬂﬁ 2.7 Library

g‘ljﬁ 2.8 Layer

A o o o
e Layer Innumenis 1990 tazaiunuatiog Miawosvoe Adobe PhotoShop Taull

Hidden layer

Qblects on layer
displayed as oullines

Aclive layer
Loched layer



P
UNn 3

s o~
IBmIautulasany

.:f 1 = o ] St g & a o & 9
Tuuniisznannedeo1 s niunaiaunduled d201151n51 Adobe Flash 8 Tu
[BK] 1 1 - 1 =4 == c’:ﬂw 9/ ] =, =& ar 9} 1 P
ungudeod Adszneusyludu lvdinsdunfiuiuimi soudamsdansaunie 1
1 3 o =y 1 s :: 1 ) =y 1 -y 1
sgluiunounmsawiulassnuludmmdng Hanue AU WALIDOAFANATIA 1HY A29814

Yalsunsumazmaiian1Fludnmdng ensaouim@n ldimanuan

[T
| ] T .
3.1 MseenuuulasiiiudemiuunazaIU (Catalogies)
A Y o 3 - aAw [ an o .f.é’ k4 J o
e Idnususudeyauazdsvesidanaaied luRfsiusi MM A
= 9 ¥ 4 1 A:’ 1 Y o ar A o
Foudoouds Salailonuazmanuosdoya lay 14N yaem s TANaAMIULULIMALNDST
¥
YOINN DA Aall
Y o = 9 A g 3 J ar
3.1.1 vYman szuaadIswazdramsitiddoyanuamUiionIman
3.1.2 dandauanafingsams e1mT 3 szuaasswazidon nseeld ooy Tngare
1 ¥
wazaRn e nomioiou naztzimsiauaaiionivandiy 2 diu file dveLINTs
v v b v
SauaasTuny  ueiasangadtuas  laonaivitsveaio ludnuazunui - lasd
or [ o w - = dl. A o 1 1 — g [
Fydnvalunuiagnioaannuise namugansedumisineg luusui - Taolomluuass
o ' o ° PN A A Y e v oW
wuniaivuanondesaslon  audwmnlssnnimzanunannudeiindwony  Tasdun
o ¢ A o » &Y B2
ur ladannia@eninys ldandnudasil
r u’: ] @ 1 o 1 1 oy dl. A e
1M TALERe Fua - afa T | nszdwyausni1, quuas Toarh, wila, miesdiedy
o o A - ar [ 9 =y ar A [ d? 3} A
dord, indpatieduilar, fnssamsitiu, mioguazsuTng, N3899NIE, ITDAUAZIATO
uaane, 1 ladunsela enuday
or 3 v ] A s Y =1 L]
SIMITALEAY FULY - VeuaUIaENISazEY, Tesauns, Tivueule, Souag v
A oA A A P o w
HAZMIANDA, INTBINBTI, INTRINDUNTDY, AZINBI A AR
] or =y 1 = - Y1 1)
3.13 siudauaaaiinssamsulde ssuaaeivazdoauasinsinveard Inela

Tudaniafivg Tan

]
ar

t:i - =] ar = ¥ = = o @ or
3.1.4 YeaNsEan zuRAWAzBuAANBAzIAs AU vBshssaniiaTiuazva
o ] [] = =Y { o o 5 =]
$1ihe Tasozualszianvesdudnidl 2 dszian fe dumihninTag i l9fuiy

datlsznoundn fu Audiivhnn Ihiludagnan



10

= ~q ¥ o a a e W o ﬂ o e = =
315 10 ﬁ]xmﬂu'ﬂhmmnmmmmsaumnwwnnmma UAINSAT HISUNUN

@ 1 Ao o [ [] A w J [] 3 o o
Wannaeveaninuiitiresaldauensis  wazimuiWanvnlmi  Tavlamusnmosdd
Y- s ar 9 _ =
niquuniiissuaidiudasaduiluiny
9 = = 1N = P b1 ar
3.1.6 Woauaaamw wilunasimwnuifesivn Tanfimanlamndaudas
SHd o d oo an o & 1 ry ° ey aa o ' 1A
3.1.7 FavimiuuzihAnsdae duissilunnivauedsziivesiiisnuaia Ana
or o ° Y ar 3 v —
weni Tasiuarue Taoldmmsquidu indwifiesy
| =) Y

a Y ¢ o) 1 a A 1o yA o o o A
3.1.8 AIAAIONANBHWUN ﬁlzl‘ﬂu'ﬁTI—J‘VlLlﬁﬂ\'l'ﬂ'ﬂElﬁ’lﬁ'iﬂf;fl’l!.‘ll'l‘]ﬁﬂ.’lﬂ‘lqiﬂ HIUIDNARNND

€

o b 3 Aaa o 9
ﬂ‘UH]']Hu”mWWﬁﬂm‘ﬂﬂlﬁjﬂﬂﬂ‘N

_—
’ numan ’
| > P | | o
‘ dnssamay ’ wiales umeflszdn ’ iy »;muammni’)iﬂ’mzuunh Anes l‘ au) ’
b date N P
rimuineuna | Weruvrulng
A L
| Yl H e 1
Ry ]
| iy || e |
. | I ~ T f i
puesisy  nfeemund |‘l.|Immmn e T ‘m?nni’uimuﬂn?ﬂmmmﬁq.l
R I ‘ T oo Tl
Dmnmnhuﬂn?mi]ai’udm m-‘mai'im“uﬂ‘n'ﬂ wila ‘ q'u.'inla n%:mngm::nrj% niain }
e R
Winus: sutie seaiu Warl “ mﬂm,m:‘ln'

[l F
Ui 3.1 uamsialnssadunsudmuiangiion

LY g
3.2 myeonuuusuuvdnyaztivlae (Lay out & Theme)
FIE R 4 & ! ¥ E o -2
dielduistoyaludulediunguy  vosdoyalduds  Aeznudanomialuns

1 o A e o 1 - o 9 o a ,; v
aﬂmmuummmm"lcm mauway‘anwmwiumuww‘l’mminmiuﬁmwmuam'lﬂama



11

A o & 4 ¥y g 1 et ' 1 d oA ' @
minzay Belaoma i dulsadmlngzlinumianivuvesnilu 3 @mfe @

b
(head), damilonn (body) uazd Mo (footer)

Vo i nan psiadu Ui Gmaill iy iGoogle | wihdveun
1
ar
Goo dui
1h~u|f11n||
[ S | T
- - = PR o
i Ewmirg Go_ogla ]I Whaia e v ] wic e Mo wiveaes
aun o fu o amwhifunns T 1]y Ust-aiviu ] ‘;J
A7ULUaNI

npx1 Google co th tu Enalizh

1 v

arunng

Wt Gooale Yhaess - Google.com in Enalish

S2008 Goaght

{ o ' ] ~ 1 o
g 3.2 FrecnaduTeanilsznouludae 3 daundn

P | d? P [ B o A Af .ﬁ’

mmmn'lumummm‘aﬁmumﬁmaﬂy"h i]gl,ﬂl!ﬂ'lilﬂiﬂﬂiﬂﬁluﬂﬂ1ﬂ101ulﬂﬂ"ﬂ’l
@ Y w @ ¥ A g a & 4 aw Y w
nHLad Llﬁxﬂ"lﬂi‘]51i]EJﬂ'l'L!ﬂ'lSal.‘HllNu“l'll”lJ’llJ’lcluﬂ'lill.ﬁﬂ»‘ﬁ'l!lﬂﬁlﬁf]ﬂluﬂ‘ﬂ’llﬂﬂiﬂﬁﬂﬂﬂﬂﬂﬁﬂﬁ
° P da i o q ¥ o
Aumiafid emnruh e ldgldenduauld

= 9 o ) n‘ul Qs .é' @ A A 3 1 A Qs

ﬂ\iulﬂﬂﬂﬂllﬂﬂ'i'lﬂﬂ']'iﬁ'lﬂiﬂﬁﬁﬂ ﬂﬂﬂluﬂ‘ﬂ'l‘ﬁflﬂl.WllMll‘Uu'Jﬂl!ﬂﬂﬁ"Nﬂ"lﬂ HIVEHARA

= 3 =& g* 1 = 1 e o o

'j'IUfﬂﬂJ'NS'l!;lﬂ"liTlﬁ'l‘ll'liﬂl"\l"lﬂﬂulﬂiﬂﬂﬂiﬁﬂﬂﬂllﬂ %131 u‘l’l'i'iﬂﬂ'li‘]ﬂ'ﬂ“h'él, AANFTULUSIN
oa o o A e | Aaa o o P v E ¥ 4
AHENUDN  LUASVDIARADWNT AN “11\‘]E)E)ﬂl!.‘]]'lJIﬂiQi'ls‘l'i'lﬂﬂ']ili]lélﬂlllﬂluﬂll'lul‘ﬂ ll.ﬁﬁvlﬂ

yal [GINIGERRIY

AU

- |
Aruuam

4 a a
TENMTYILALLAL

[ v

a3t

‘ljﬁ 33 !.!.ﬂﬂ\‘i‘i"lfJﬂﬁ!.‘UH‘l"lLWiJlﬂllHl']iJ"l



12

Ll J -d‘l.’ 1 \
3.3 mslagniauluiieniunazaay (Features)
y o o Y o o g U aoa
Weliduladannse @aoududidhsudiu lsaniedlda 1doduiifss@ninm v
a o l 1 3 1 1 v ] = v
suiludedldgniauiudlomudazdmfmnzey msensldgamnaiuly wie avsld
1oy 1 @ 3 1 o ' a ' s q¥d ot '
aniauit linoandewauih hilenszdwads wnndwed Wy i iddulsddvnalng
=y - dw o o o3} [ o 1 ]
dull wie ilevweadulednaanuilmennimuazviannureandesiuluudasd
Wludu
1 ar 1 a = ] W 4 1
Taugnidumana eziinn i led dwsidenldaoandesiufuiion 1dun
Al d A dy ¥ = 1o = A o
3.3.1 Saleeenlal Fedruilvz Mdmaiianmsdedygnonies lnonvesInaaioyinn
. o ar 1 o ma  w o
HaAd (Streammg) BZLﬁﬂﬂumﬂ‘%’ﬂU AIUYDINTIUUSHIWNINALN
3.3.2 unaeimm nie Sadamin sxtinnldiudmunminuiissive lan, Unssens
[] 4
w1714, voshszan naziiiow ludiuvesdauiauaasiingsmns Vau
A o 1 1 or -2 ) 3
3.3.3 iy taziwufinw vzriun 1 ludawsesdudauanciingsanis e ldily

[ ¥ v
seunny eidenwusvazidoalunuindesyouiloniiug

v
=

d o Vo =i d!y 1 1 =
3.3.4 gladlyd vminnldfunsuaasnoezBoaveaiiamlududesya Tunsdin
b4 v

wlonmiua Jnnwerana 1 wih

11

3.4 IWUUWIFaE15042 (Upload)

A s = as o o o 9} e O 3 =] =S 3 3 = ad o

doduilunswenndy ladiadadn SuiludediinmsdaduaslsauaTaugivnes
- 4 A 1 a 4 d A & w1 g s ¥ ¥ o
wielsaimansadoudedumeinia  enageuuaziuduindvlsdiannsaldnulai
a & A aw ycly ¥ ¥ 4 oy ¥ o a A4 A Y w
savia e lingugldan Tdnansdldamaiedumdeionan vio dahasvzdealimlye
A& o Yo d o U3 <
werhanud lvldd i lalinmduysoiinniga

cundy AW
AuauliAnugHved Jaafidoans
o o ¢ & o Y o o

~ 5e95umson InanIduuy Fre ieanvazainlumssn Inaadeyadiviaduas

msud lulusuing
n:td? A A 9 w9 4 u’: t:ld? o o o o 1

- Auifsmodmiudoyalva Flash Wenue uaslitundsesdmiumsiianiae
oA luoung

=1 or ¥ 9 A d LY b4

- fimssesiumsloudnodoya data transter T80 tilosnnidu laawanndiv Flash

o d s oo do W : 4 4 $ o ¥

soi iy lsdtvnalugninivia hl  diefmandhenduied  SealduTinumsToude
Y 4 A
HoyannInanbue

_ 5ee5ums a1 IWE Flash uas IWdani ddua il ludylod wu xML dudn



uni 4

Han1InNaaod

o fano w (d’l’ 9t 1 =3 3 1 o ] @ dv
nU‘lcﬁﬂWWﬁﬂm"’n‘ﬂuUTUﬂﬂlﬂ’J ﬂﬁgﬂﬂﬂﬂaﬂﬂﬁuﬂﬁﬂ llﬁ$Hu?ﬂﬂ;&ﬂTﬁﬂﬂllﬁﬂﬁluﬂﬂ’]

o ETREN | d"
muludulaa aanelalil

2 ([usfAunwudIu i
\ &, Sgt.Mo|Thawee Folk Museum

g *
"_-..,,Q \

By = %;ﬂﬁ |
i
_ J

[ s ef | oo h ' e, "

W | e | e | W | e
T L it | B e | L)

Copprght 200 Ehreghts ressrced Team foe e
araittd vaas vadihetadd atsda s nbutedd Wonwinds haisaliduiug e

{ ' ar =1 L4
i 4.1 amamsdnnlsznoumdnueai lud

]
=} 1

L4 or A
- 713UN 1 TIUND Li‘luiaiﬁuawaﬁﬂmﬁ

-
1 ]

3 ] ¥
_dauiiz dnuilow diufuinaaswadoya Flash flanua

h.

1 of

[ =1 o ar o { 9
- {UN 3 FIUI0A1TUAN (menu) mmmﬁaﬂm%’aﬁmmmwu

L] 4 1 =] ° a a =
- g 4 dauie Wudnlsemanyand



14

3 Y]
4.1 vvan
) or @ L'a & =) ar ] 3 ' 9
wimanveadulad nse Sendunlsumniu  szgninauedlejluiveams
o Ama a ¢ o A A4 A o A a A
SapuruRfRsAuHumHaTnerIMIgy Faimdsuandislnngseanuh y

» 1Y
amsorn Wwuilorameludnniug 1@

IRy
e .
i qusiRlEsA

gﬂﬁ 4.2 mwuﬂmwﬁmﬁ'ﬂmmﬁuhﬁ (homepage)

T o
4.2 FIUdAUNAIINIIAMSI
Tudauvosmsianaasiinssamaszgnoanmiaily 2 daumu uwudwazisuimg
[ w A aa ¢ & 1 d’ Y] LY A y.-ﬁ' b =1
fanadag uazdeadduiifisiag dsluduieeiauaasinveaniodddiuininelueda

o 1 o‘ ar
uazSauaas laouvamulss Towl 1 asnm

1 4.3 muuaRedUTANEAAITINT AT



S

91015 VAUANVTINSSANIS

(o113 3)

( aamjuumn

‘9
‘nouasu? < < Ju © )
\\\ N & 7

o '

4 [ ar = 3 o 1 @ ey
U7 4.4 niudasdauiandaiingsanIignuuusamiii 2 FIunUUARNE AN

W SAUNWULI 3965
*; Sgi.Mal.Thawee Folk Museum

e - -9'

(5 ’ o
HuRds whed "'l""”'":“
wils . Yo
Baleony Thei kitehan

wiinandan Haedicrsth,

b @W Baskels

- ¢ b i'w.a\-‘
nf’.gﬂnuiﬂi 1 2 Upstyirs Qéuu\-
Anmpwal Lreps d [ (Fenspatirmeiirintt

D T Eord R

& gniing m T clothing ond costumesr

Saing

[~

ml‘cufnudm
Fish tpeps

I B S

. . - | L i 1 . - ¢
(gt | [— - N - qsgiag | 1 g |
RN GnssAnts KoIMANINW voIRs:AN valAL asnIudunu

Copyright 2003 ﬂlri@1t<:e wved TE'drl'l for used,
AaMAYHAE bawn 1‘nmnﬂmuuhm‘mwﬁ.unmmadnulauu mum..-mhm'a sgsfia rioy lrnumny o

sl 45 nMdAIE TS ALAA LTINS TAMS N |



16

A WWSAMNWUIL dinD
¥, SsgiMalihavee Folk Riuseum

/. “-’“B‘Ihulﬂ‘

gnf‘.-ﬁn?-w e (Arunnm.u
o> h'upom anumrd@g vuls

Stoirnpy

“rinee L‘ihf'rns,
Larps

\aFetaues
Musical toels

Binthplace il
P\ 22 LpR f o/ w7
- - b ) - -

- - I .
RUlRIn unsinng KoIRAnIniWw dalfs:an Yo AU ny:oludundl

Cc-p,mht gUU B righ |ts 1ezeqved, Team for uzed,
asuBuiIg Laas l\ﬁxnui\\muuv.id.u‘hhunﬂwa uﬁuln A wlanednfaigagina nuuﬂmuum M

‘ljﬁ 4.6 ﬂ'IW!!.’ﬂﬂ~1E’I"Ju’i]ﬂuﬁﬂﬁuﬂiiﬁﬂﬁﬁiuﬂ 2

MUY e

4

. 2 ¢ o
Wonoalvusyrmedhiauaes Toymn

s lamsquedmnTy

e

.

NAVKWIKAN

;]
- LA-}\.\:

- Sl
YA \\\‘\\ N

‘I.l‘ﬁ 4.7 mwuﬁmmamamwﬂumummms IAUAAIUNIIANT



17

1 o
4.3 TIUIAUTAINTH
Ed
1 o = = = A
Tuduvasnsdanaaenmil  sgnsudasnmuilesniug lonluedn  Fagiiuuves

a o o 'y 1w W = [
n‘u"lqmwmmuamuqmauﬂaunmwﬂmgu"lﬂ 360 23f1

5171 4.9 mwdedaszuvsaiunniinyu1d 360 oem



18

A A
4.4 BUINUINITAN
1 o = dy or [ = = 4:{9 1 ao w o 9
clumwummzaﬂu i)?zﬂ'l'illﬂ'ﬂﬂﬂ'lﬂﬂ'lﬂﬂ'l\?“l]ﬂﬁﬂSzﬂﬂﬂﬁl'lﬂu’lﬂclu“ﬂ‘ﬂﬁﬂmcﬂ a3y

o
o ar a o
53““3?11”]5“1“1“1]“}111l%’lllﬁz“gﬂﬂﬂﬂﬁ’qﬂﬂ'ﬁﬂaﬂlaﬂﬂ

- i
TnupefiMey,

51 4.1 nmdedeszuusatiimwignnsognd gueonld



19

4.5 HIIAVDUDY
il [)
Tuniavoauauil szdsznenlddomnud Avanninldsunsuuray $1mau 4 1pwil

LY | 1 d' 1 (%) B L £=) df d‘ Qr = Ay 5 b1
’)ﬁﬂ'l‘ik'ﬂuﬂl!.ﬂﬂﬂ’lx‘iﬂuﬂﬂﬂulﬂ ulﬂllﬂ LIAUNHWUN, muwmu"lﬂnmmu WUWNNIUNAIY 1O

) [} 2~ . b4
s ugmilou Wudy

|55
(. doudun nAukdIKAD
e e ; 1 ——
o ol _‘y . _ B L F 4

S § - ¢ ] v 1 ¢
— | =% iaoninudannoonisiauinua)

R
| | ?
i ‘ ! a
IR S

R R S L 1 [
| h [ P | .\.. ¢, _-»-ﬂ_" s
i P e | Rl "Jﬂy ¥
N AT IO
| SR i

T e | o — A v v -

inunuwun anW'an]lJnUUUU InuguINIULNadyY

g 4.13 mmuaaanudntiduludu led



20

Li
4.6 MIHYBINIZATHAUN
A G o g ¥ :f Y oo 1 o
Tuvpsnszauaunnsaivveiaiy  dwihiléwannnn Flash uansnnne
A { o =] 1 =y 0’:
PHP daldidonldszuuduveiaf R uanuiioy waziuTamuwesa fie SMF Forum Aads
s led esldaamlandly dnvazinsdmiddiugludouusveanii

o A
P19

o ‘3 <
DI BENHHAUNHANN
Sql.Maj Thawee Folk Museum

aunfa A Gaee Loodned fioredwn deda

aiat admin twenmen)
A e B | A nsstosunaudio s e

w1t 8MF - Jusk Installed!

2 Pl oAum |

W Jathawee Museumn

| nisfawn S admin
Ay wanulampids 2 nej T Ret Welcome to SHF!
Ay mafvnniArcly inapenuioads W wirAssnd 1 vl i 23, 2008,
11143117 pro

Tathatees Museun - Sudng 1o

nﬂﬂn'l_-:_H_\nuylnh[

2 el Tu 1 vhiin Tee 2 muvlin, améniivga: uncleBE
9 nrdiAet "Re: Welcame o SMEF ( qurnfud 23, 2008, 11:43:17 pm )
qn-r.\ﬁn"::.‘-xmm‘a%u
[afidbur]
sl
0 wsariT, 1 andn
‘ Gt 15 wetidhant

admin

sulfooulmiinmiza: 3. ooulamiinniaga: 3 Guli va 12:17:58 am)

517 4.14 NINLARIFIUVBINTTATUHUNIN

u



a
Uhnn s

unagy

5.1 agdwamanaaes
Qs o o de a9 1 ~ o o s
nmsianntu lydRfsiuauiuemd  dszaunaduivmugailssdinves
-:i”éwy' ~ VYo v o Aaa W ¢ A d 5/ o oo ow <
Tnseendi FalddonsBouddmivinssus Ahuldawanudesmsvorguaiinsnnd
a & 4 dor ot N ¢ ° = o9
sovie GuleadalinmdnualnnuasnnlumaivaususzdsgaanuaulelumsFouives
o ¥ 3 o d 4 .
yanaia liidnd e Tavaursan@ousuulyd 18R hitp:/www jathawee.com
=) @ oo oo oA gAY Ve o o 9 ] g W oo ar o
pnznnisifisudniuifsdasiaug 7ldsaindo led it Aulsainsdus
d:’ 3 1 A A =5 2 ] 3 1 J g =
fnthuimd fnnudgalumsdisuinnd Meluidvesnnuaisay, gnau uazidenm
e = o ¥ 3 iday o A 3 ¥ '
suawolugiwuivndilaldhe wanidods fo mslnaadeyaszlanannuni

A k4 J o A = v oA (-] oA
L'NENﬁ]'lﬂilxﬂfl\ﬂﬂﬁﬂl‘uB'H"I‘Ylllﬂ']‘wmﬂﬂuhl'H'JLLE]S51Uﬁ3mﬂﬂQﬂlﬁﬂ‘l’lﬂ']ﬂﬂ'.]'ll’]lﬂ"]mﬂﬂ“]

5.2 dayrnmaznsamaun v

= Y
@15199 5.1 msrauaasdavuasuuamalumsnnilym

tgym wmalumsmidym

d oed 3 A ~ & A 9 o 4 o g o
b Sy lae i Inaad diosnniinmmaeulna | 1 denldmsianninled Taouiau lyd
1 = o ] (] & [] o o
uazgaduilugmaumnn iududeny Gavzdnldduledlnanls

'l k4 []
3 w5 lidos il Tnaatom lua e i

AoImI B
d 4 1 o . 4 o
2. msudawaveai lednszgnuas T 2. 1115211 pre-loading 1N1% iHo InaalWald
1 A o a0 a
Anlileg FoeruyIaineusuBy

3/ o L7 o
5.3 U@ HaUHESTIHIUNM TN
Y 1 = o 4 o
5.3.1 ulgsssuuunaoiuanwmanwifagniglumh@uiu ielagidhaiuled
annsosuinlan ldadnsdoniies
o o ~ 1 o @ o \ 's A o =Y & o o O
532 Savszuumievefinssumooulad  vieduuewnamdy  Tasdeviuilu
o . V=t e 3/ a4 9 @ oA W o4 1
AnYIE Social Network lnBMsuaniasuanuanuasfiud M UNNEAUNDUY Tauly

o w g A=a o c‘n; 3/ t = I 3
innmWmﬂuwmnmmwumummmmu




22

a Aa a o w a =
5.3.3 705 A0 luAREAUN MTaiLaaUiUEY
5.3.4 anmaihwnauazgnaumen TllinlysmSeonlasunassosenlueuing
° { o = w o 4 ' {
5.3.5 g Indudasitinaieludy lad Tusanuiludd iWomonns T gsun
' - 1A -1
vielnanse hilidumesiia

) @ o 3 A v I=] Y
5.3.6 annsoth lwalszeeudludruuitvesdonsGoumsaousun 18



¥ A
IPNA1ID NN

o) d T o = oo w 1 T I=]
(1] W3A3 Yaauvad, fansns. Huglan : ARsSaaiiurhu 9. 2549.

n‘ay 9 '

21 Wsf3 ysuuad. gnaafidindam. fivelan : ARsdamuin 9md. 2548,

[3] wifl3 Ysauuad, Tuhnuavs. Wonylon Fifin ARt 9n3. 2548,

[4] Wi ysanvad. T3 ARsFut Fauezoudausan Siduenn yssevad,
fweglan : ARAusTALTY S, 2547,

(5] "bivsngFefuds. “Adobe Flash :
http://en.wikipedia.org/wiki/Adobe_Flash

[6] Rich Shupe, Robert Hockman. Flash 8: Projects for Learning Animation and
Interactivity, O’Reilly Media,Inc. 2006.

[7] Emily A. Vander Veer. Flash 8: The Missing Manual, O'Reilly Media, Inc. 2006.

(8] Joey Lott. Flash 8 Cookbook. O’Reilly Media,Inc. 2006.

[9] "lﬂﬂsmg%aﬁmia. [Onlinel. Available : http://www.flashkit.com/tutorials/ 2007



MANUIN .

fegamsadanuaelysunsy Flash

3 R . 1 -dy = = W Qy W &5 o
NITAT N movie cllpcl‘uﬁ’mui]zﬂm'mdﬂ'l‘iﬂ'lﬁﬂﬂ‘l‘iiTS‘N‘])"LN'Iuﬂ’JU Flash Yuuuilu
o Y 2 o v oo 4 4 oo 4o g
dete 1 3w Tavahadd dmsinivhilddssnenluemiug Fedediehosadradhy
or ] dy = g o 1 o 3 [T=v-1 J o qy v: o
Faetail wrmiamsademiqurjuoud dwaitnmstugy nuedeaumsladuan migu

¥
uoud 1§ Taulidnsdede il

H or 1 o/ { ‘;
510 1.1 swdedsgildimiquitaievudae Tsunsy Flash

o' 1 o W
o at1e'lWalna Audda File, New...
e BIHUAYHIAYDS Movie MUNABINS AIWFATI Modify, Documents...
¥ A M o = A 2 dj 1 1 & o A ¥
o ldinFosio Ynand 1 2ameiuginuninvesiuoug nmuainudems as

a 3 g 1
MU UUDU93 I ulszam 1.5 - 2 ¥l



VesaymenitAranssurnans suvingdeusdas

| 4941411
iy
/g
2550

s 1.2 amnldenmmaiss

A A'l 2 9 s o o 3 o [
ideniniesiie / Nadunsedngiled 1oy 3 du awaedi
te d w1 o
aoaduusnfogiudnveadd weahadumanihmnliuuoud fuaes
k-
duil lidesvieiuun

@unaw Tnaluszan 3 1u 4 v83235 Womhduanvey

71l 1.3 awdlans naduidy

& A4 A k
idann3osiie
A ¢ Hda 0w = & ¥ 4 A 1y Ao oy
Aounndmnysudunse uTnanwnarsveady undesiiglnullugaasd lidu
TRamiY (Fadaed)

# o 4 & 1 [ 9 s ' 3
naifudreveandine i deanaiinzvuindues e Uutdiduifmwdaediaie

audu



s 1.4 amAldnslfudulfa

a 4 o~ k

IaanAIodue

° '3 ) U = 9 1 A :
u’lﬂ]']fﬂl1ﬂﬁﬂﬂlﬁuﬁiﬂﬂ3uﬂﬁ1ﬂu'ﬂﬂ3@5 umﬂﬂﬂu <Delete> INDAUN UATUNN
a9

921845 Tidulde 3 1dumelu

<Delets>
\4»

517 1.5 amuaasdmiidesay

o 4 m § 4 ! o : .
Thundnadnluiuind Idduldaduiaw vaz 1sdudega iaimenudinatly

»
<Delete> aUNY

<Delete>
<Delste>

:'I 1 Ay A =
‘i‘lJTI 1.6 MALARAITIUANADIAVNUAY

26



27

v
Qs o ] 1 o
funeuda lszadndruseauaauoug
-~ d‘: I | D A e{ r o ar ]
Bonniealo = NamuasuanyMZAIAIDN N

o ddi’ =9 Y o =y or =1
Taofvadig, IdY LazA NUNUBUdUTTY NYUSIALINY IS

dy o " & ¥ 3 o

A3a3i Tuduniaduveson ™ LA INBUIBUINENI TN
¥ ¥ 1 1 v v
or ] 1
FupouileziumsalfougusevesiimaouIdidlugilammaon
A A A k
[AenmnInaile
A o d.gd'. W i ~ [ o'y [] g]:‘J A Y e o o
@eunndndfyuuudnovesiitifon sznuhnndiglnudlugaasinduinyuiiny
k)

' W kY o ¥ oA d | ) a A A ] o v 4
antfudnofne 1y udufeunndilSuldyuvesdimaon Aounagludwmusianma
YDIAIUUY AIRIDE1S

-
s o o

A4 o =
fdnfudnymils e S ldiuglamumdoy

g @ A A o =
iﬂﬁ 1.7 Llﬂﬂ\’ﬂ'ﬁﬂ'jUﬂTwﬂlﬂﬂUnlﬂuﬁ’lulﬂaUH

a

A A4 A k

[[oOMAIDIND

A < dy = A o as =
lﬁﬂulH"IﬁUTEIfcluz‘]Jﬂ']ulﬂﬁﬂu lﬂﬂugl}'lﬂll']ﬂUﬂU'Ni

& s Al w ] - a dy v ' A
lﬁﬂu!u1ﬁﬂ’]‘]f‘nl.ﬁua]ﬂﬂiTuﬁ1ﬁﬂlﬂqaﬂﬁ1ﬂlﬁﬂﬂﬂ ﬂﬁﬂﬂl'ﬂulla']ﬂﬂljﬂ <Delete> IWD

4
AUy

¥
'y ]

Ydnsudufituesnu1nvetaNM ALY 2 AU

<Delete>

o o

g7 1.8 ugasdufidesiinsay



a A A a (ya o~ v
AANIADNINTDIND ~IAadNdAIVADINIT
4 Y] 1 A 3F o [} o
Nnanay ududeu liuduseavesaumdey 1hitluesayuoud
= = d'l. =) @
NANLEDNLIAIOIUD
2 = ¥
IANARNIUADINIT

-] A A ’ % 3 ¥ =y 4 =y
thandgadizdsaily ©denlidludumavoniu adniaiduid

310 19 wamsmImd

a_ A A & O
aanmemaioeile Y neaen uazayn
enmaesilo 2 Nailn

d'l ar 9 ] o
MBUA9A1 YN iazin s WATHINYUIUA

1 { o 1 o
wlddwndumdinfuouadagl

n:i A ] o
31 L1 mwiaasnmRNaInyuoud

28



29

] (] ] ¥
e lddmmiguuda ssgmirlfidifeadrenmaden luadad

1 ] i
31l 111 nmudasiImSquijuouAi e vy

& 4 :v-:? o o o 1 ¢ 9 o ) ] = J ¥ L]
mwa'lmmammﬂummsauuuﬂumnm ‘i]SH'li'lﬂﬂﬁtﬂﬂﬂﬁ'lﬂ“]ﬂ']'lﬂ‘uuvl'.] 11'11’&1’

[y [ M
dsznenlu timeline aliiAamsinaon Tuaaedeliii

¥ o o) > o o 3 o
. ﬁ%’l\?ﬂuﬂuﬂllﬂﬂlﬂugﬂulﬂlﬂﬂﬁ 1ﬁﬂ5ﬂgﬂllﬂ1]ﬂ15ﬂ%’1ﬂﬂ;uﬂuﬂ Tﬂﬂuﬂﬂ@n, ﬂu‘lﬂ ez
y 4 o ¢ Sl ¢ o
ﬂ’lﬂ'ﬂa\‘lﬂl‘lﬂuﬂlﬂueﬂulﬁwﬂi (Layer) llﬂﬂaﬂﬂﬂ'lﬂlﬂlﬂﬂ?)ﬂu']ﬂuﬂuﬂ iim‘ﬂu 4 ¥yl
Y

o o o
197 A3

[ eye

(@ mouth
(& robot
4]

31l 1.12 mmmmmwﬂswaﬂwu‘lﬂu

- o y 1 4 o @
o AIUAUMTNTEHIVUVIIN ﬂﬂﬂ‘l]')ﬂul.ﬂ‘illﬁ 15 99uaasiaod llg’llﬁﬂﬂﬂ’lﬁﬁ Insert,

q o 1 o
Frame o l¥nniaweSuaaskaiiuszoznm 15 wiaom sniuowed eye

a@n‘ IE.I.ll‘o‘“‘ill'lzﬁ“lrzé“.'an'
Deye . @ . " A
IP nose . @ ] Create Motlon Tween
L
CETIN . ey
» Remove Frame

51ft 113 Wusuliyaaoeiinnuen 15wy



o o't - s
o ABNEIWBTOU) IHADINWISIAWDT eye

30

&80

n (&) eve e + @
[P mouth « @0

& robot « 9§ 0
244 8] @

4

! @ =] o4 4 ' i
517 114 msiemaweiswite lildmae luulaounlnesvazides

1 o 1 e’: o Qy w3 o &
o @enAnmvoauoua IfasundIL Nease saufluingFuAenualeiigg

Modify, Group

= o 4 o A g <
o aanvnlumsy 5 ysaawes eye Ao Insert Keyframe ioainnisifasuilas

o0 Keyframe

i 4 [ H E
vogaranmulumlsuil (Funfavumlalunat s miaam) dannggadilumsil

[} ¥ [ ]
o aanlursud 5 udrduidananfineari e I Tuuamiaud luaremyu o

] ¥
wsud 5 azalsngrihaensud 1o Group Asil

&a I & scenel E@}G@

== =

1 5
o insoeiia / mndurinaen9mnages

) o imsavdiuvesaa IfianmnIza 9NN

517 1.15 nwfavduaamenntdn

U



31

F » ]
VINTUATNT scene 1 tHandug Inuansihailng

1 1 ¥
@antdsu 1 dadsun 5 udndendda Edit, Copy Frames v1intiniand lnanly
wlsu® 10 e Edit, Past Frames Twirlsuh 12 i@ondde Insert, Frame Woilsu

o o T oo
1F w3 eye N s Y 15 (5

» Timeline
; |e I]l- Ole lﬂ!

31 116 sunhims ldse

o d'i = c; b 1 ] =
aaodi U !wﬂﬁﬂﬁiﬂﬂﬂﬁﬂﬂlﬂﬁﬂ 1 Llﬁ']ﬂﬂl‘l?.l <Enter> 92WUMAUANYRIE

ASZNIUAINTA

0 0

i w LS ] A 3
711 117 dmsgurusuaifinanioulnudy



HMAUIN Y,

M39514 Pre-Loader 8819918

»
@ = ' ' W
139 Loading 1y 131heaei e Idnenhuaas vwiaves I linas ngunmin o
al ." A ] : o ] [ 4 Q’)
dignasad1e yWluu Pretoad Movie Mayiinaniiior e Wfeusudiida Inamhiug
[l [ o
og uaz litlauveun

1 LT ] 1] :
nou Awidet1ene il

X _— 4
1. Wad oy ldauTasniniinnyg Insert > New Symbol 1iio lapgfion New Symbol

ﬂsmgﬁum‘lﬁﬁmuﬂ% "Loader” 0411/ 11904 Name nazi@ioniilu Movie Clip

Create Hew Symbel

Norw: [ Loader]

Behavior: (S Movie clp
C button
CrGrahic

&
]ﬂ# 2.1 ﬁ%’wuﬂ%uumﬂa Loader

A A ay ' 1
2, o luduveansaauss Movie Clip 1 14in304ile Text Tool RuMdBR2M

E - o
"Loading" 180 Front fidBan1sie Idimanzauduns ¢

| wreid s, - X
B . w71 '
0w "
Y
i
i
: -

wad Cm o wa R Y use o >
-~

|Lnading|

.

£ f ¥

o a { d
i 22 Anidenaluiuinhon



33

=y 1 A L n‘: A -] ) .
3. naniendoursufi 10 udanaiu F6 imivldinioslioiondiof1il "Loading lilmsdhe

60 a!{ﬁasb{wnuhnngww 3,

[Loading]

<! : . |

4 o o
1 2.3 dimuadrunudsnly timeline

a ] g ] r o A ]
4. adnidandearsuh 20 udanaily 6 einiuldinsesilodondiofri "Loading” Tmavn

Loadiqg|

£

g1 2.4 Amum timeline

¥
o 1 A
5. ommiuinad i lan 18 lumsuf 4-9 uas 10-19



I"‘l‘i,’n”gi
v
4. i¥
4 -
JUn 2.5 AMun timeline
] 4 9 P '
) 6. 14%94 Properties 1%188nN Panel Tween 121381910 None (4 Motion
1 Preprtl: ¥y ' mar : =
]T Frams \ r— o) [o]scals | Sand: [tiors > g
RS , Eae o o e '

Labeltype: uuu ;flnn Ev; :l Sy [!wrl i"il"““' ;v.{l i ]
iOokemtapuh Csyre Clsran T4 serad salaciad. “
4
x m ) ® x m = @
! )
P

vad - TR R R SR T L Y P § R
o, o S\ Y | Y | (N —- _ A Cw
4 } :

Leading

< y

1 d O ar
71 2.7 adumaniounalinuiag

Tl - L] A ar Y
' 7. 1A anf131 Scene 1 tHoindamiimanuesusunsu Flash

34



35

T UntRled-1* " B ﬁ]
s | @ T |

- a W o
qiii 2.8 TndnndyTndu 1

A
8. WnA Cirl + L (Woi3un Library

Fwiivay-OEedsy o - e
Orw tem n lbray

Name e Jusa
© Loads Movie Cip 'i']
a8 @< v ¥

it 29 DalovsidifeBonldyd

< ' o d
9. 8711 Movie Clip ﬂ#ﬂ’n "Loader" sNdeanfu uﬁon]auu%mn Layer ({1 Loader

FEST T8 N A : 4

aﬂﬁ 2.10 ﬁmﬂ‘% loader 31116 1U timeline

a ' o a P &
10. pRRABNYoUNTUT 2 UBURIWDT Loader IAINA F5 uaziiy imwoidnuilauniwed udada
4 iy o 4 ' :
#o Profile twefii 19t miunadoya nie pnmiezuaaifinwes Profile Iinaveansuil

3 ypatatwed Profile ud11na k6 (Iinwed Profite af@1nid 1984 (1007 Loader)



fenmdhe o o
_ Iﬂl:ll 5 w0
B 7 T SR =
{4 Loador s+l
7 profie N BN
I
v g [ minl w1

i 2,11 Awmuavutamsy

- £ 4 o d d o '
11. minowesBanilaniwes udadien Action udamaunItiowes Action sgdniungaves
¥
o oA
via 2 iwo e F6 $oaf | Laz 2 vouniwed Action

L A
10 '
.'Za‘_-::f-,'t i
L Loadar
@ profte
wad & ] wn] W

A Y] ) -
a1l 2.12 ahuaweidmivldmds

a 1 o P o o
12. adnvoursun 1 udna Fo iy la Action Al

RPAVRNOVER ® o2, i,

iFrameLoaded () { /7 Tddwaa mlssaedin vsvseand Frors le

gorpAndPlay (3): 7/ Lidwndebiouy
)

4 ]
1 2.13 uorAIMNS Action script

36



37

a d P v ﬁ N [ d’
13. nanivTui 2 1dane F9 W ld Action Aeil

RPAPOVEW ok id

gotokndPlay(1);

d v . d
3u 2,14 1d Action Seript TWiumsui 2

a < o d o
14, WinAinilsud 3 vounwed profite i Iiidoyafiozsuaas wld 1y ey Foyaiminn

1 ] J A L r
#oa tmport 191311 Library fewfvayh it ofun1syia PreLoad adadne



MANUIN A

5
HaAINaIA 1008 Flash 11109AM

di 4 a < o & a v
Tadwigalumsuarnadale Wuddeiunsddlouas Flash vuaawasuiu &

a, d v oW 1 a ] e oo
Flash 1au3 TeMiaua uazlumanduiud Flash ngaidu 33 Tedngadudomuiu dnlu

i38emnsnldfids Play0 e Stopd wmILRUAEUNTENYAIGUYEIIAToTY Flash 14

-]

A = a
710 3.1 afunsemnanudainaseug 38 ls

A =y = d -y
1. mwlulvdonns Flash #1180unedalvdqa todunudy 19 finuua Library udaaind

r-% 4 L] [} J. J A
yluaddlendosmninuaasmannwinn Library 891y o dumdandeamaluiun

i
' aay_d { .o " .
2. seilng lavzdonveniiduTuaialemmanasnld 13 lusuiiemiu deamssou

[] r S o [V} P =
Wy lns  uazisdeantsI® Flash  diudwaudsyIdohdusmaursunduluaidle

»
Foans Tavsa Tusianie 1 usinseenin Yes
A: L) - 4 A A
3. aouiha ISy Tuada Tt B lufhiihends Sediee 1 s Windesile

1 ﬁ 1 Yo ad n: o m
e nainssuiennudsIMiuIa Tefidae Asgud 3.1



39

LI o

1 3.2 adeghjudmicuiesnyaay

4. Winoaflosng adreqilijudmivdacu unengaidu Sogilit 2

5. Wlishdifengiliudmiuduau wdainadd F8 szalsingiidha Convert to Symbol
Fruan Wudoq Name dmuadedu Tuaily bilay tazdmua Behavior il Button iriaudana
OK

6. WidhdBongilijudwiududu udanafid F8 wudn findwa Convert to Symbol Tudes
Name fimuaiiu biStop liazfmua Behavior (14 Button (311420 OK

7. Wihdaini bieley fleglufiuiivian wdlfivima Actions demmiuliflduensn

»
andaldnalyl fail

on (release) {
_root.play();
}

24 d P P v - y o
8. Whdndni bistop foglufufihan uda1ufiwina Actions devinviirlduonsumaiuld

adlugail



G-

Music Video

4 e L) = 4
717 3.3 Fredunsnaanada left 14

40

»
apuilia lovousifildas a1y Flash Goufounda uazijuniunumsimuunengamu

z 1 ‘ L = 1 Qr Q)
siamesfiniounda v TN 1 nefd CirltEnter iNodananay Flash fozifivda Toidusiud a9

P & 1 & ] d d 1 ad Y | d
317 3 uaziiionaify Stop tMYALEY Fiash Noviui13a lowurznyadun l1do uaziide

r 1 4
ARTj Play ozl Flash Suidusnass dawa i3 Toidumudae

- T £ A
Falouvy Steaming wnlWd FLV Saudd35msuaasia lolunwuiudatiluns

» ¥
UAAIHANLY Streaming iouny uadniion13a leatoly Flash vy liawssiwn141dan

' w ' < -t
wisrehgnsm iy Flash 01d7 widusaoun1éiiulad Wiy FLV (Macromedia

] ¥ - -! w
Flash Video) fiovudanion s Flash dsdoyadd TovinIWa FLv fluuimaana feghWindane

AN { 4 4 ' & o
awnsnd3a et Il hanidug 1880 HaiiiTmanlasd3a Tewa lu Wil FLv #ail

o
or ] o (Y} 1 & - =y d
L Fewduaeudig aniade “dadeddlodau Flash” Wodunesnialedhanlilas

S | o
711 3.4 vhaew Tnind MediaPlayback aa T3 lutuiian



41

2. nanumiay TuaaTefidesmsunadiing FLV Tuwuua Library udadion Properties
fagilfl 4 ezlsngniien Embedded Video Properties sovniul¥ndnAiify Export 1
Usngniliding Export FLV dhun Wddeld FLv Aeamytufinasliluses File Name
udanandiify Save Aoz MG FLV dm3ullumsiaas Touvy Streaming 1&a
yintunoumairesh I 1§ MdSa Telupluiuuves FLV 12 Ssdrqadosms
e FLV dmiuindialedus AZsuiidauatunouusndnnta Fanomi'l e
soziuald Fv Wiinfy hisufudenh W38 Teduniiulugao

- ar A (.2
18338 10870 Media Playhack Component nasmans1 18 IWA3a 1o FLV uda
-, J 1 IA 1] 1
uaaawada ol WdpliuunaliléGenntndeld  moedhluTlsunsy  Flash  14f
aouTniwddmsuuaaialonndd FLv inliGeudssnds suivamimen Tnundaa
2
13
\ d’ A e [ - A d v SIS
Ta M lufunam uagdwmuadiaieg Snoudmioumniy

WmEsgN
v (3

£T -] [ « @ = 83 & B & & =

[ = — -

wuad RN S TN T

|
|
\,
|
|
-
31J'n 3.5 thnou Tnvud MediaPlayback

& P o v d
1. WTisunsy Flash Mx 2004 Wad e TWdionens Flash unilwl desimivTdfinuua
o v d Z 4
Components i&2141hda nnen Tniuudie MediaPlayback #3317t 5 aaunmeBlufun
4 N d e & d
ane uda19inTeaile Transform amliuviinveanon Twnud MediaPlayback fiogluiiui

#1au Wi unamudens @smssduiuisunnanmuesialodan)

4 d d g A4 d d
2. 1ndniinen Tnud MediaPlayback fiagluiumvinm udalfivaua Properties szivtu
[ A dg d
IJI.I Launch Component Inspeclor 'lﬁ'ﬂnnnﬂuu llﬁ')\]ﬁﬂﬂﬂ{]?ﬂlua Component Inspector

J 1 1 a a
Y Bavefiswozdoadng oglumuundagii 3.6



42

Il'm" pani 'm pi r Coee i
B ssvne, )
Parurvobey Imlﬁ-—l

Media Piayback

" T3]
vemmps [T )R JEIET)
[mamanes I 3o .

Ll ;
[t nid ] |
W ramamraly May !
viuse Mefrrred Meda Soe

Fripid Atde] AHc

Conirct Mool 0 Db Fep

h e
Condrak ey v A tn
on
-
L I_

o .
717 3.6 swnziBsAA139 TuwiWa Component Inspector

3. lutea URL wpawiua Component Inspector Wld URL vedlWd FLV Haamsinn
HARAIND
4. uBNVINTITaTAAAenAug MoTuNIIA Component Inspector Miraule1Aid

- Automatically Play dmsudmualviaudaledaTula

- Use Preferred Media Size thnsufmualdiuvmanivuuiavesiale

- Respect Aspect Ratio dmiudmualdinmdasidiuvonnaiale Tunsdifia
15U u11AvDs MediaPlayback WilHuvuRved3A 1o

- Control Placement dmiufmuadumrsussununoa Insa Srozldegludumis
1Ave9 MediaPlayback

- Control Visibility imiufmmuamsuaasuaunea Insaties uaas On), hinaas

ar L & 1
(oD, niounassa Tuiadoiuhd e e dunisveauounsalnsa (Auto)



qsﬂ'_u_--a----o.-

| W 1 o :l
917 3.7 Medranadnin ia

43

4 ' A o o
ilennetiadeSuudosuds AWnafd CulEnter iNedamaney Flash foziiuia e

< . 4. d & = ‘
faeu TviiudMedizPlayback uamsini Azl 3.7 Taumannintou lgiale e dwmis

] A 1 1
A9 14820 Timeline MlT1nguaounn Insa uag a3 0AURUN TIEULASNYAIY

¥
sMaszduRusedinleldondu



MANHIN J.

nslraagismainaeueniniyly Flash

fudmilssaBauaasmatinuvesszuunasinidaidumshanludauvesns
TrargilnmeInn1uuensa Flash WULEAING Favznanedumeuuns g uiumsetas
n35179) &ait
1. sdhaenaisInaiduanung 400x300 1da save 131 desktop

Document Properties

Dimensions: Iﬁ (width) x ISOO px {height)

Match: ¢ Prister (" Conterts ¢ Defaul

Background color: [_:I

Frama rate: I 25 fps

Rulsr units: |Pixels -]

Meko Defauk: | [Tk ] cama |

2 :
31 4.1 adraenanstiuantmg

‘ ! o o 4 44 4 £
2, Wvgunnm 400x300 1nta' 1314 path Ava f flash Fatrathan Quitil fash Herdrdhuan
ol
oY1 desktop)
4.4 i
3. nlavude layerl 1u flash 1ty image loader



pidll mage loader [

vl (4] )t |

o r ar A
11l 42 FrothamadndA1R

' P
4. 0§19 movie clip quqifum Tao' 117 iy Insert > New Symbol... #58nA Ctrl+F8

|Insmt Modfy Text Commands
Pl memnbd, o, Chl4FE

Timeline
Timeline Effects 3

(B B

Scend

31 4.3 adrayriindl

4
o

A4 . p
5. A4Y¥971 empty movie clip udufion Type il Movie Clip



Create New Symbol

Name: | empty movie clip

|

oK
Type: @ Fovie dig) Cancel |
_besk |

" Button
r" Graphkc Basic
Linkage
Identifizr: '
AS 2,0 class: I :

Unkage: [~ Export For ActionScript
™ Expart for runtime sharing
I~ Export in first frame
I™ Import for runtime shating

URL: |

~ Source

Browse... I File:
Lrme.. |

Symboal,.. | Symbol name: Symbol 1

I always update before publishing

I~ Enable guides for 9-slica scaling

] »
i 4.5 dsiswoziBundydnvel

6. AANT Scene 1 nie 1 L iendulyds Scene 1

s Scenet (% Symbal i

@ || 4] wlo] W L

g‘ljd 4.6 ﬂﬁﬂ1ﬂ§0 scence |

46



47

-
7. Ty Window > Library #38nA Crl+L

Contral | Window Help

Duplicate Window Ctrl4+-Alt+K -

Toobars 4
v Timeline Ctrl+Al+T
"5 v Took Ctrl+F2 "w A
| I} Propertlas ’Illllll
Common Librarles »
Actlons F9
Beshaviors Shift+F3
7 Dsbugger Shift+F4
} @5l Movie Explorer A+F3
Output F2
71/ 4.7 @en Library

| i o P s |
8, int{1¢14 Library 210 movieclip 1o¥130uan 1ne 130 stage Tao s Bimpdouuves

stage

ey W
|ex-ipg ~| &
4 ltems

+
Name

lﬁ ey i IT|‘D

4 o Ll @ cl
210 4.18 Fretaradnin 18

g da v o
9.l properties 404 movieclip uﬁ”mq%a instance name 91 imageLoader FN;‘IJ



¥ properties ' ‘Mkers | Paramaters
| IMwle Ciip ;I Instance of:  empty movle clip
|lmagoLoader SWap...

wi[0.0  x:]0.0

8 woo  vfoo

L] ¥
a‘ﬂﬁ 4.9 ﬁx‘léﬂ‘h"l’ movieclip

& ' & )
10. o414 layer vl #8091 text field

(7 image loader « « W !

DEl @ |t

; o
71l 4.10 ahanwe s Tvaidun

r
11, 14 textbox a1l stage Tau14n04ilo Text Tool

48



Y

49

&
311 4.11 textbox Aignadieiiu

»
12. luwos properties Y94 text field Widoniily Dynamic Text o m% Instance name 1

infoFicld Aag1l

IDvnamlc Text || A |Arla| Ll
[infoField Ay o o] at [Nomal

w:[10400 x:[1400 | @ [sngeline | [am) o &
m[17.7  wif1388 | @ |

4 -] QIEY
31N 4.12 AvuARuEUTAYBA text field

1 S A
13. a814 layer 1n2Uu1 As¥071 buttons



LI @ |l 4] e
311 4.13 a¥raiawwed butions

' ) <
14, a2 tfariann 2 dfas Taolld sy Insert > New Symbot wSena Ciri+re

]Insart Modify Text Commands
Few Symbiol, o CEHHFS

Timeline »
Timeline Effacts »

=4 | EvEEE

r

Scena

g1 4.14 319 symbol Imidmivinjy

I yod YAy A4 ' o
15. m%m]un 1 71 button 1 uﬂznwmju‘n 2 (a2 3 31 button 2, button 3 AN

4. 2 . 2
91§71 4.15 Fade 1 button et

16 Magalijy awdoams

50



®

a4
199431

TP

#

v

L)

Az

1l 4.16 Magalfoztunlélu work area

W Y >
17. dhtjuviamnfafadratinnn a1 stage Asgyl

1 3] L8 ‘ 4
AinYafinssinmloly stage

m@mB

4 a 1 o o t J
U 4.17 uaasdredanadnimsadiaguiiuan

1 4
18. fa#le instance name 1H1juusazijudt imgbin, imgbtm2, imgbtn3 AidAY

51



w1 properties "~ Mtars | Parametsrs Lo
I E |Movie Clip || Instance of:  button 1
| imgbtnt Swap... |
wif165  xi[164.0
H:|17.7 w27l ‘¢
W% properties * MteYs™| Pariistapy = e

Instance of:

button 2

|% |Button |
Ih'nqbtnz SWap... IITrackas on

wi[165  x:[194.8
w177 w271
1% proparties * “Mfiare srs | BaramwEaE

|{% _:l Instance of:  button 3
Imgbtns Swap... I ITrackas butta
wi[165  x:[224.8

H: W.? v:l 271.1

i 24 o u d £
1l 4.18 dadeldiurfuinadistvin
»
19. afhs layer ‘luwﬂ’um ﬁ'ﬁa'h actions

(7 buttons J
[ text fisld + » B
[? image loader e« » B

waa @ |1 W'l %

31l 4.19 adrsowwed i miuTddaa Action Soript

- A 4 o .
20. AANUNAAIVIINUYDA layer NHOI action uddon Actions

52



[/ buttons Creats Motlon Tween

|

() text fleld * * Wi InsertFrame

[/ image loader -+ 2 Remove Framas
@

WaEl

| Insert Keyframe p
o) Insert Blank Keyframe
Clear Keyframe

Convert to Keyframes
Convert to Blank Keyframes

Cut Frames
Copy Frames
Paste Frames
Clear Frames
Selact All Frames

Reverse Frames
Synchranize Symbols

Achiore
3117 4.20 1t Action Script 1 timeline
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21. 1d Action Script av il

imgbin1.onRelease = function() {
infoField. visible = true;
startLoading("picturel.jpg");

IR

imgbtn2.onRelease = function() {
infoField. visible = true;
startLoading("picture2.jpg");

b

imgbtn3.onRelease = function() {
infoField. visible = true;
startLoading("picture3.jpg");

b

function startLoading(whichimage) {

loadMovie(whichimage, "imageLoader");



_root.onEnterFrame = function() {
infoLoaded = imageLoader.getBytesLoaded();
infoTotal = imageLoader.getBytesTotal();
percentage = Math.floor(infoL.oaded/infoTotal*100);
infoField.text = percentage+"%";

if {percentage>=100) {

delete this.onEnterFrame;

infoField. visible = false;

}

IR

}

4 . ’
22. 1 Cel+enter iWeNAADUNI IMaanmnnmoyenumasswa WisuaTody
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TeternTuldlunisAa AN text file asTusuh 1 Asii gl 5.2

Mnaamind IHd

var sitestext = new loadVars();

<
sitestext.load(“sites txt); 93110 5.3

REFTOD=N N
Be Ldt Sewch b [
Stip s sARSP COMMART ARAUSURLs shep /v or ]

1P €0 th hip jfwww comman co thhitp /Awww ardu co
miEnd-t

=

a w
zd'n 5.3 1d Action Script WAL timeline

o

Wadrafind tWa vieoruiluing IanadsewnTilsunsy ASP, PHP u3e Cold
A b S

Fusion ﬁ‘lﬁ nﬁffﬂyamﬁ

Sites=§ ol ,ﬂaz,ﬁ 03&URLs=http://www.xxx1.co.th,http://

www.xxx2,co.th,http://www.xxx3.com&End=1

o or ’ 1 A ] LI )
welidunlsogananifie Sites uaz URLs el muaiidunls mnfinaroesd
aeaiiugaang TaolWddsnanezihdoya luaaslunes Inisus ComboBox

P dd . 2, d
arainwes vl Ao nuua labels Tnunandnijy Insert Layer g31/f1 5.4
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uddesdioanva TneluRuidenrmmdesmsuaasluses Frame Tuwiua

2 o F
Properties Wndinvaudion Insert Keyframe‘lmﬂﬁm 2 qzﬂ'n 55

it

!

71 5.5 1d anun Iffumsy

i ldaniudneTumawi 2 #ail...
sitestext.onLoad = function(success) {
if (success) {

if (sitestext.End = 1) {
gotoAndPlay(“‘end”);

3

else {

gotoAndPlay(“start™);

}

}

}
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Insert Keyframe g1 5.6
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310 5.6 A lidumaui 3

o o 2 )
Wainnos i ComboBox WEasuf 3 UMIALES Combo Hedieludes
»
2 4
Component (1t CBOLoadSites wnedoauunaslminenTuilond lundnuameunimdsui 3

d
vounwe? Actions ieiion Insert Keyframe g3 5.7
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g 5.7 1dfrefs Action Scriptlfiuivay

v
o o ° 1w . 1 o
o ldmuaudndu msfmuanidauals Sites uag URLs, Ahnondves

d :
ComboBox ferAsuazgimiuaasiilu ComboBox

var ComboSites = sitestext.Sites.split(™,”};
var ComboURLs = sitestext.URLs.split(",");
CBOLoadSites.addItem(* select site ™');

for (i=0; i < ComboSites.length;i++) {



CBOLoadSites.addltem(ComboSites[i],ComboURLs[il};
}

& o ar ' v o
amiuadiafan sy seaduns Tuaamis ndduundai
CBOLoadSites.setChangeHandler(*loadSite”);

function loadSite(component) {

var SiteURL = component.getSelecteditem().data;
getURL(SiteURL, * blank™);

}

F . ) o a4
Tumlsah 3 9218 Actionscript DBANIAST

var ComboSites = sitestext.Sites.split(“,”);

var ComboURLs = sitestext.UREs.split(“,”);
CBOLoadSites.addItem(* select site ™);

for (i=0; i < ComboSites.length;i++) {
CBOLoadSites.addItem{ComboSites[il,ComboURLs[i3);

}
CBOLoadSites.setChangeHandler("*loadSite™);

function loadSite(component) {

var SiteURL = component.getSelectedItem().data;
getURL(SiteURL, “_blank");

}

stop();
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oy al ey wpmty l  B ity Ol R L 1)
LUy v R ] LT L P ey R T

' o . d
7471 5.8 adaualdfumsud 3

edrsanuatursafl 3 veamwes labels ufafede end ggalit 5.8 wiafhms
Publish 'lvln‘Tnu'thf‘fnﬁmuﬁﬁ?a File > Publish nfumeassnandens Indiathatu uds
nandonculad sxuaaam st uaedaduladdsnd g mindoms Tnaa'tld
XML 1ﬂ11ﬂ1qu%ﬂ§nﬂn New 1ﬁanﬂnyw‘f':1miﬁum unzimunuaywa Ui 300x100 fin
@A

anney Twitug ComboBox Wiendmunadonou Tniiudithy CBOLoadSites unz
adununadenin sdruawedlmituinde actions ufanAnyaidon msert Keyframe
sl dudndulussaf 1 Taoldansuldasdl..
Herdapauidng XML
thisXML = new XML();
thisXML.ignoreWhite = true;

#3unHad$u LoadCombo tife Taa Td XML
thisXML.onLoad = LoadCombo;

#TnaaTd xml

thisXML.load(*sites.xml”);

stop();

yntflaladrailed i tunts Tnandeyanslu newTuslend
function LoadCombo(success) {

if (success) {

Himuadanys

var BaseNode=thisXML.childNodes[0];

var ComboSites = new Array();

var ComboURLs = new Array();



var ThisNode;

nmuasiareadnou Tudend
CBOLoadSites.addItem(* select site **);
imaasdoyalud

for (i=0; i

ThisNode = BaseNode.childNodes[i];
ComboSites[i] = ThisNode.attributes[“siteName”];
ComboURIs[i] = ThisNode.attributes[“siteURL”];
MNdsirasaeuTudond
CBOLoadSites.addItem{(ComboSites{i],ComboURLs[i]};
}

}
} gl 5.9

d o
9171 5.9 uermailaiduns Inaadeyau textbox

o

. d :l 14
w519’ IMd XML Aismuadeyandesmsaanldaudail

thisXML = new XML(};
thisXML..ignoreWhite = true;
thisXML.onlLoad = LoadCombo;
thisXML.load("sites.xml”);
function LoadCombo(success) {
if (success) {

var BaseNode=thisXML.childNodes[0];
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var ComboSites = new Array();

var ComboURLS = new Array();

var ThisNode;

CBOLoadSites.addItem(* select site *);

for (i=0; i < BaseNode.childNodes.length; i++) {
ThisNode = BaseNode.childNodesi];
ComboSites[i] = ThisNode.attributes“siteName™];
ComboURLs[i] = ThisNode.attributes[*'siteURL"];
CBOLoadSites.addltem{ComboSites[i],ComboURLs[i]);
}

}

}

stop();
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